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Program Description
Drag And File streamlines and simplifies the work of managing files on your computer. It offers several 
unique functions, such as a directory finder, a duplicate file finder and a DOS command utility.
Drag And File works at several levels of sophistication and integrates with other management and utility 
programs. The result is an uncommon degree of flexibility: Drag And File can be configured to meet your 
needs, your working style, and your experience. When you need more, Drag And File delivers. 
Unlike most other Windows file managers, Drag And File allows you to highlight individual files and tag 
multiple files, which makes possible batch operations on non-contiguous groups of files. 
Drag And File offers a broad range of file management tools:

· Drag-and-drop file move, copy, and delete

· Viewing of all text and most graphics files

· Tree and branch batch operations on all files

· Single click execution of most frequent tasks from a toolbar, including viewing

· Separate windows for each drive

· Full configurable hot key control for hands-on keyboard    execution

· Formatting and diskcopying for floppy diskettes

Main window

Drag And File displays a window complete with toolbar and menu choices for each drive selected. You 
may open up to 12 drive windows simultaneously. 
The entire program can be run from a single small Drivebar which floats unobtrusively on your screen. 
The Drivebar makes complete directory and file information just a mouse click away.

Drivebar



Drag And File includes an Uninstaller to remove the program and changes made during installation. 

Note:    Microsoft Windows' file-handling requirements may make it necessary for you to delete the 
uninstaller file itself. 



User Help
Drag And File is designed to present options and procedures clearly. The window components, including 
icons, graphic and text buttons, and directory tree displays, make evident what to do and how to do it.
Along with ease of use and the ordinary features of file management, Drag And File offers an unusual 
degree of sophistication. 

Canyon Software is committed to producing software that is useful and productive. To help users make 
full use of Drag And File, Canyon Software maintains a technical help line for registered users from 8:30 
AM to 5:30 PM Pacific Time.

Phone (415) 453-9779
Fax (415) 453-6195
BBS (415) 453-4289
CompuServe  Go CANYON
America On Line  DanBCan



Setting Preferences
Drag And File offers several ways to tailor the program to meet individual needs. 

Related Topics:
Options/Settings
Configure Toolbar



Options/Settings
From the Options menu you access the Fonts and Settings dialog boxes, which allow you to adjust 
several aspects of the program's performance and display.
To change fonts:

1. Select Fonts from the Options menu.

The Fonts dialog box displays. Available fonts are those which are installed under Windows, or 
under a type manager working with Windows.

Font options dialog box

2. Make whatever changes you wish and click OK.

The changes take effect immediately and remain when you exit the program.
To change Settings:

1. Select Settings from the Options menu.

The Settings dialog box displays.    The Settings dialog box has four pages that are accessed by 
clicking the mouse on one of the four tabs at the top.    The first page is for general settings.



 Settings page

2. Enter your choices for warnings, multiple windows operations and window appearance.

Overwrite Warnings. When enabled, these warnings appear when the files you are copying 
or moving are about to overwrite files of the same name.      These warnings can always be 
overridden at copy or move time.

Multiple Window Operations. Drag And File lets you perform operations on tagged files in 
more than one window. These choices allow you to specify which operations you would like to
perform in multiple windows.

When Copy from multiple windows is checked, Drag And File will perform all file copy 
operations on the highlighted file or the tagged files from all open Drag And File windows.

When Move from multiple windows is checked, Drag And File will perform all file move 
operations on the highlighted file or the tagged files from all open Drag And File windows.

When View files from multiple windows is checked, and you choose the view files option 
from the Drag And File tool bar or the "Actions" menu, Drag And File will view the highlighted 
and tagged files from all open Drag And File windows.

When View directories from multiple windows is checked, and you choose the view 
directories option from the Drag And File tool bar or the "Actions" menu, Drag And File will 
open up a view window with the listing of all the files in the highlighted and tagged directories 
from all open Drag And File windows.

When Drag and drop from multiple windows is checked, all drag and drop operations to 
other programs include the tagged files or highlighted file from all Drag And File windows.    
Drag And Drop operations to toolbar buttons will depend on the configuration for the action of 
the particular button.    For example, if you have Drag And File configured to copy from only 
the active window, dragging files to the copy button will only work on the active window no 



matter what you have configured for drag and drop.

When Zip file from multiple windows is checked and you click on the zip button on the 
toolbar, the highlighted file or the tagged files in all the open Drag And File windows will be 
put in the resulting Zip file.

Window Appearance. These choices follow the pattern for Microsoft Windows: cascaded 
windows are overlapped slightly, and tiled windows are fully visible.

 Programs page

3. In the programs page enter the names of auxiliary programs that you can run with Drag And 
File.    Drag And File will try to fill in these options automatically when it is installed.

Compression Programs.    Drag And File comes with built-in routines to perform PKZIP 2.04 
compatible zipping and unzipping.    However if you'd rather use an external copy of PKZIP or 
use LHA or GUNZIP you can enter their locations here.    You will notice a "Browse PKZIP" 
button on the right hand side of the dialog.    The legend of that button will change to "Browse 
LHA", "Browse GUNZIP", and so on depending on which field is active.    Choosing the 
browse option will enable you to browse through files and directories to find the program 
location.

WWW Browser.    If you like to access World Wide Web sites on the Internet, you'll be glad to
know that Drag And Zip, the compression management program that comes with Drag And 
File, is designed to work seamlessly with many Web browsers like Mosaic and Netscape.    
When you download a Zip, LHA or GZ file from the net, Drag And Zip's zip file manger will 
automatically pop up and allow you to extract, view or scan the compressed file for viruses.    
All you need to do is enter the name and path or your Web browser in this field.

Editor.    Enter your editor of choice in this field and you can edit a highlighted file when you 
choose the edit file option.



 Drives Page

4. In the drives page you can configure the drives that are available to Drag And File.    This is 
particularly useful on networks where you might want to limit the drives available to different 
users.    The settings in this dialog box will be reflected in both Drag And File and the Drag 
And File Drive Bar.

Select the drives that you want to have available.    To make drive selection easier, there are 
check boxes where you can turn on or off the different drive types.    Drives that have been 
selected will be displayed below the drive list box.



Viewer Page

5. In the viewer page you are configuring the viewer program Drag And View Gold.    Drag And 
View Gold comes as part of Drag And File.

Check the View highlighted file automatically box to have the view window automatically 
view each newly highlighted.    If a view window is not already open and you want one opened
automatically, check Open view window if necessary.    The third option, Bring view 
window to top, will bring the view window to the top whenever a new file is selected.    
Autoview will only work if there are no files tagged.

Drag And View Gold runs as an icon on the bottom of your screen.    You can change the 
behavior of how it runs, change the icon caption and even hide the icon by choosing the 
configurations options in this page.



 Zipper Page

6. Choose the Zipper page to configure Drag And Zip.    Drag And Zip is the compression file 
manager that comes with Drag And File.

Like Drag And View Gold, Drag And Zip runs as an icon on the bottom of your screen.    You 
can modify how the icon runs, change the caption and hide the icon from this page.    

Built-in Zipping.    The default operation of Drag And Zip is to use it's built-in zipping and 
unzipping to manage zip files.    You can also have it use an external copy of PKZIP by seeing
that this option is not checked.    If you are using an external copy of PKZIP, you should make 
sure you know what version you are using and see that the PKZIP Version 2 or Greater box 
is checked appropriately.    When Drag And File is configured, it will try to determine this 
automatically.

Output Directory.    When you compress files or extract files from a compressed file, you 
need to enter a directory where you can put the file or files.    You can choose to have this 
default to either the current directory or the directory where you previously placed the files.

Drag And Zip allows you to modify its display to show you the information that you are 
interested in knowing.    When viewing the contents of a Zip or LZH file you can choose to 
either display any saved path information or the CRC (cyclic redundancy check) of the 
compressed file.

7. Click OK to save your changes and exit. Click on Cancel to exit without making changes.



Configure Toolbar
Drag And File's button toolbar is very easily modified allowing you to add and delete different buttons.    
Programs can also be added to toolbar buttons.    All toolbar buttons can be configured to user Alt or Ctrl 
key combinations as hot keys.    Alt hot keys are shown in the lower right of the button as black on gray.    
Ctrl hot keys are shown as white on black.    There is also an option to completely hide the toolbar.    If the 
toolbar is hidden, the configured hot keys are still active.
To modify the toolbar:

1. Choose Customize Toolbar from the Options menu.

The Toolbar Customize dialog appears:

Toolbar Customize dialog

In the list box on the left appear the available button choices.    The top two entries are SEPARATOR 
and NEW PROGRAM.    SEPARATOR adds a space between two buttons.    NEW PROGRAM allows 
you to install a program as a button choice.    In the list box on the right appear the buttons that are 
currently part of the toolbar along with their hot keys.    

To add a new button
1 Select the position in the Toolbar buttons list box where you want the button to appear.    The new 

button will appear before the selected button.    You can also drag buttons in the Toolbar buttons 
list box to modify their position.

2. Select the button that you want to add from the Available buttons list box.    You can also choose 
SEPARATOR or NEW PROGRAM.    If a command button is already in the Toolbar buttons list 
box, it won't be in the Available buttons list.

3. Choose Add or drag the button to the right hand list box.    The button will be added.
To remove a button

1. Select the button that you want to remove from the Toolbar buttons list box.    Click on Remove or 
drag the button to the left hand list box.    The button will be removed.

To add a program
1. Select NEW PROGRAM and choose Add.    The Add Program dialog will appear.



Add Program dialog box

2. Browse through the directories and files and pick the program that you want to associate with the 
button.    If you want the file that's currently highlighted to be launched with the program check the
Launch Highlighted File With Program box.    When the mouse cursor is over any of the toolbar
buttons, a little window will come up saying what the button does.    You can enter a custom 
button description in the Button Description field.    If no description is entered, the program 
name will be used.

3. Choose OK and the button will be added to the Toolbar buttons list box.    If the program has an 
embedded icon like most Windows programs, that icon will be placed on the button.

To modify a program button
1. Highlight the button in the Toolbar buttons list box.    Choose the Program button and the Add 

Program dialog will appear.    Follow the directions for adding a program.
To add or change a button hot key

1. Highlight the button whose hot key you want to change or add.    Select the letter of the hot key 
that you want to use from the drop down list box in the lower right of the Customize Toolbar dialog
box.    Choose Alt or Ctrl if you want the hot key to use the Alt key or the Ctrl key.    

When you are finished making changes to the toolbar, choose OK.    All changes will be saved and 
windows updated.    If you choose a hotkey that is already in use, you will be warned before saving the 
new hot key.



Auto-configure
Auto-configure preserves changes to the next session of the program. Changes you make in the Settings 
dialog box from the Options menu, or changes in the dimension of the drive windows you make by 
clicking and dragging the borders, are automatically saved and remain in effect as the default choices 
when the program runs again.



Drag And File Drivebar
About the Drivebar
Using the Drivebar
Configuring the Drivebar



About the Drivebar
Though small and unobtrusive, the Drag And File Drivebar can provide access to all your Drag And File 
functions.
The Drivebar consists of a floating bar containing buttons which represent your drives, removable and 
fixed drives, local and networked, and a control bar. Click on a drive button to open a new drive window. 
Click on the control bar to open a menu with choices to control the Drivebar display and to close all open 
Drag And File windows.

Drivebar

The DF Drivebar normally floats in the foreground, above whatever application is current.



Using the Drivebar
To activate the Drivebar, open the Drag And File group window from Program Manager and click on the 
DF Drivebar icon. 

Drivebar icon



Configuring the Drivebar
The    Drivebar can be altered to fit your needs. 
To configure the Drivebar:

1. Click on the control bar in the upper left corner of the DF Drivebar icon bar.

The control menu appears.

Drivebar control menu

2. Click on Display Vertically (or Display Horizontally) to select the configuration other 
than the one currently in effect.

3. Click on Always Visible to make the Drivebar appear on top of other programs.

4. Click on Close All Drag And File Windows to close all open Drag And File drive windows, 
but leave the Drivebar icon visible.

5. Click on other choices as needed to Move, Close, open a Help window, or to see information 
about the Drivebar.



Fileman Launcher
Fileman Launcher is a utility that helps to manage all your Drag and File auxiliary programs, such as Drag
And View Gold. Fileman Launcher is installed as an option when you install Drag And File, and a menu of 
its choices is accessible by clicking on Fmlaunch in the Drag And File menu bar.

Fmlaunch menu

Using the Fmlaunch menu you can do the following: 

· Add and delete items to the list programs that Fileman Launcher runs.

(Fileman Launcher can run up to 12 programs with Drag And File)

· Change how the programs are run 

· Add command line arguments to the programs

· Quit all the programs 

· Rerun the programs



Drag And File Main Window
The Drag And File window is divided into several functional and information sections. Drag And File can 
open up to twelve windows simultaneously.

Drag And File main window

The menu bar contains drop down menus. They are accessible with a mouse or directly from the 
keyboard by using the Alt key in combination with the underlined letter or arrow keys.
The information sections contain data about the drive currently displayed, number of directories on this 
drive, the space remaining on the drive, the    files in the selected directory, and their total size.
Note: Drive data may be incorrect for compressed drives.
The drive buttons allow you to choose which drive information the open window displays. Double clicking 
on the icon of the currently displayed drive opens a second window displaying that drive.
The lower half of the window is divided into two panes: information in the left pane concerns directories, 
and information about files appears in the right pane.

Related Topics:
Choosing files and directories
Menu Bar
Drive bar
Toolbar
Directory pane
File pane



Choosing files and directories
Drag And File, unlike Microsoft Windows File Manager, allows you to select and work with directories in 
the same way that you select and work with files.
Drag And File marks files and directories by highlighting, tagging, and dotting.

· Highlight files and directories by left clicking on them with the mouse, or by using the arrow keys 
to move the highlight bar up or down over a listing. Only one directory or file can be highlighted at
a time. Operations like Copy or Move can be performed on a highlighted file by clicking the 
appropriate tool, or by using drop down menus or keyboard shortcut keys. If any files are tagged, 
highlighting is ignored.

· Tag and untag files or directories by several methods:

· Right click with the mouse to tag and untag; Shift-Left click to tag contiguous groups of files or 
directories.

· Right arrow to tag; left arrow to untag.    ( This method is not available when viewing filenames 
only )

· Spacebar and Ctrl-Right click to toggle tagging on or off.

· Ctrl+Left Arrow or Slash tag all files or directories

· Ctrl+Right Arrow or Ctrl+Slash untag all files or directories

· Dots mark files which have been copied. Dotted files may be reselected as a group for other 
operations.



Menu Bar
The menu bar contains the headers for the main drop down menus. Most menus include information 
about shortcut key combinations to activate commands from the keyboard.
Drag And File includes in its menu bar extensions¾drop down menus inserted in the File Manager's menu
bar by utility and other programs. Examples include the Stacker file compression program, and the 
Microsoft Backup, anti virus, and DoubleSpace programs.



Drive bar
The drive bar includes buttons that represent all accessible drives.    Click on a drive button to change to 
that particular drive.    Double click on a drive button to open a new Drag And File window for that drive.    
Additionally, files can be dragged to the drive buttons for copying or moving.



Toolbar
The toolbar displays a series of buttons that activate tools or shortcuts.



Directory pane
The directory pane displays, in a tree format, all directories and subdirectories of the currently selected 
drive.



File pane
The file pane displays a list of the files and their attributes contained within the currently selected directory
or subdirectory.



Type to File/Directory function
To locate a specific directory or file, when the appropriate pane is active, start typing the name of the 
directory or file. Your typing appears in a small window that opens over the directory count in the lower left
corner of the window, beneath the directory pane. As you type, the highlight bar will move to the directory 
or file which most closely approximates your typing.



Drag and drop functions
Drag And File uses all the mouse conventions associated with Microsoft Windows programs.
When you drag and drop files and directories to a directory or drive button, a dialog box opens. Using 
options in the dialog box you can specify a Copy or Move operation, the name of the file or directory, and 
use a browse feature to specify the path.
When "Drag and drop from multiple windows" is turned on in the settings dialog, all drag and drop 
operations will use the highlighted or tagged files in all open Drag And File windows.
Files or directories can also be dragged to toolbar buttons.



Toolbar functions
Drag And File's toolbar contains buttons which make the most common file management tasks easily 
accessible.    Functions and programs can be added to or deleted from the toolbar by choosing Options\
Modify Toolbar.



Using The Keyboard
Drag And File allows you to access most functions directly from the keyboard as well as use the mouse to
select functions from a drop down menu.    All buttons can have Alt or Ctrl key combinations assigned to 
them.



File Menu
Use commands in the File menu to perform the most common functions used to manage your files and 
directories.    If the command has a button associated with it, then this command can be put on the 
toolbar.

Related Topics:
Copy
Move
Delete
Rename
Edit Descriptions
Undelete
Launch
Make Directory
Find Files
File Attributes
Associate
Multi Associate
List All Files
Quit
Close All Drag And File Windows



Copy Shortcut: F8

The copy command copies directories or files depending on which pane is active.
If you are copying a single file, the file may be renamed as part of a Copy operation, if you type the full 
pathname of the new file in the text field in the Copy/Move dialog box.    If you are copying more than one 
file and enter a path name that doesn't exist, Drag And File will assume that you want to create the new 
directory and give you the option to create it.    
The bottom of the Copy/Move dialog box contains additional options:

· Use the browse button to easily choose destination directory.

· Perform the operation on just the current window or multiple open windows.

· Turn on and off overwrite options.

· Change the copy operation to move and vice-versa.

· If the operation is being performed on a directory with branches, the operation can also be 
performed on the entire branch.



Move Shortcut: F7

The move command moves a file or directory depending on which pane is active.    All the 
options in the copy dialog also exist for Move



Delete Shortcut: Del

Use the Delete command to delete a single highlighted or one or more tagged files or directories. 
The dialog box which appears when you invoke this command is the only confirmation you will see of this 
operation.



Rename

Use the rename command to rename a file or directory.    If multiple files are selected they 
can be renamed en masse with wild cards.



Edit Descriptions

Drag And File allows you to attach descriptions to files.    These descriptions will be maintained when files 
are copied, moved and deleted. Use this command to add or edit a file description.

Note: This option will not be available on the File menu unless View Descriptions is turned on.    The View
Descriptions command    appears on the Options menu.

.Note: For more information on file descriptions, see the section Working With File Descriptions.



Undelete
Undelete is not part of Drag And Files commands but many programs install undelete programs into 
Windows File Manager and Drag And File allows you to make use of those undelete programs.    If there 
is an undelete program installed there will be an undelete menu option.
For additional information on using Undelete, see the Help menu in the Undelete dialog box.



Launch Shortcut: Enter

Use the Launch command to launch the highlighted file.    If the highlighted file is a data file this command 
will run the associated program with the data file.    If the highlighted file is a program, then the program 
will be run.
If no association exists for the type of file you have selected, Drag And File opens a dialog box in which 
you may record an association for this type of file.



Make Directory

Use the Make Directory command to create a new directory as a subdirectory of the currently highlighted 
directory.



Find Files

The Find Files command searches for files in selected directories or drives.    If you wish to 
search for a file in selected directories, select the directories that you want to search.    You 
can do this in multiple Drag And File windows.    Then choose "Find" and enter the filename 
that you want to search for. Wild cards are permitted.    Alternately, you can also choose to 
search for the file in the current drive or multiple drives.



File Attributes Shortcut: Alt+Enter

Use the File Attributes command to open the Attributes dialog box.

File attributes dialog box

Use choices in this box to assign or remove attributes which are useful in managing files, and which the 
operating system sometimes assigns    automatically. MS-DOSâ uses four attributes and a null condition:

· Archive

· Read Only

· System

· Hidden

· No Attribute
The Archive attribute is assigned by DOS to a file which has changed after being backed up.
Read-only prevents a file from being edited or deleted.
System files, designated by DOS, contain information about hardware and system configuration. They 
cannot normally be deleted or changed.
Hidden prevents a file from being included in a DOS directory listing. Drag and File, however, does 
include hidden files in its display of files in a directory.    
No Attributes specifically eliminates any attributes assigned to a file.



Associate
Use the Associate command to associate a program file with a file of a particular type identified by its 
three-letter extension.
For example, files ending in .TXT are normally text files and would be associated with an editor such as 
Windows Notepad or Norton's Desktop Editor.
To record an association:

1. Click on the Associate option from the File menu.

2. Choose the program file from those displayed.

-OR-

Click on Browse to select a program file from another directory.

3. Click OK to close the window and record your choices.



Multi Associate
Use the Multi Associate command to associate more than one program with filenames of a specified 
extension. If you want to choose among different word processors to edit files with a .TXT extension, for 
example, you would use this command to list those word processors.
When you double click on a file with such an extension, Drag And File opens a dialog box which allows 
you to choose one of the designated programs associated with this filename extension.
To record multiple associations:

1. Click on the Multi Associate option from the File menu.

2. Type the full pathname (including drive, directory, and filename) of the new program.

-OR-

Click on Browse to select a program file from another directory.

3. Click Add to add the program to those displayed in the current associations window.

4. Click OK to close the window and record your choices.



List All Files Shortcut: Ctrl+Enter
Use the List All Files command to open a files-only window which contains an alpha-ordered list of all files
on the drives you select.
To list all files:

1. Select this command to open the drive selection window.

2. Select the drives containing the files you wish to list. 

A click of the left button of the mouse toggles drive selection.

3. Click OK to open the file list window.



Quit

Use the Quit command to close a Drag And File window.



Close All Drag And File Windows

Use this command to close all open Drag And File windows, including the window from which the 
command was selected.    
The DF Drivebar is not affected by this command.



Sort Menu
Use commands in this menu to arrange the order of the files in the file window.

Related Topics:
Sort by Extension
Sort by Filename
Sort by Date
Sort by Size
Unsorted
Save Sort



Sort by Extension Shortcut: Ctrl+Shift+E

The by Extension command sorts files by the three-letter filename extension, in alpha order of extension, 
and by alpha order within each group of files of the same extension.



Sort by Filename Shortcut: Ctrl+Shift+F

The by Filename command sorts the file list by filename in alpha order.



Sort by Date Shortcut: Ctrl+Shift+D

The by Date command sorts the file list in ascending order of date, from earliest to latest.



Sort by Size Shortcut: Ctrl+Shift+S

The by Size command sorts the file list by size, in ascending order, from the smallest to the largest.



Unsorted Shortcut: Ctrl+Shift+U
The Unsorted command resets the file list to the original order before other sort commands were applied.



Save
The Save command saves the current sort order as the default.



Tree Menu
Collapsible Directories
Expand One Level
Expand Branch
Expand All
Collapse Branch
Collapse All



Collapsible Directories
Use the Collapsible directories command to toggle on and off the display of a fully expanded non-
collapsible tree or collapsible tree.    The collapsible tree works similarly to the one in Windows File 
Manager.    The default is the collapsible tree.    If you choose to use the fully expanded tree as your 
default, you should see that DFUPDATE, a program that was put in your Drag And File group, is moved to
your StartUp group.    When Drag And File operates with a fully expanded tree, it saves a copy of the tree 
to disk.    Each time you load Drag And File, it will read the copy of the tree from disk rather than re-read 
the tree anew each time.    By adding DFUPDATE to your StartUp group, DFUPDATE will be running in 
the background at all times and the tree file will be updated automatically when other programs create 
directories and Drag And File isn't running.
Note: The following Tree menu options are available only when the collapsible tree is selected.



Expand One Level Shortcut: Num Pad Plus
Use this command to expand the highlighted directory tree one level.    Only a tree with a "+" on it has sub
directories and can be expanded.



Expand Branch Shortcut: Num Pad Star
Use this command to expand the highlighted directory tree and show all of its sub directories.    Only a 
tree with a "+" on it has sub directories and can be expanded in this way.



Expand All Shortcut: Ctrl+Num Pad Star
Use this command to expand the entire directory tree so that all the sub directories are showing.



Collapse Branch Shortcut: Num Pad Minus
Use this command to collapse an expanded directory branch.    An expanded directory branch has a "-" on
it.



Collapse All Shortcut: Ctrl+Num Pad Minus
Use this command to collapse the entire directory tree and show only the root directory.



Options Menu
Fonts
Settings
Customize Toolbar
View All Details
View Filenames Only
View Descriptions
Show File Icons
Show Toolbar
Show DOS Command Line



Fonts

Use the Fonts command to open the Font selection dialog box. This allows you to choose one of the 
Windows installed fonts to use for directory and file listings.



Settings
Use the Settings command to open the Settings dialog box. Choices in this dialog box allow you to: 

· manage overwrite warnings 

· enable operations on multiple windows 

· choose viewer options and window appearance 

· modify zip file manager defaults

· specify a text editor.

Note: For more information on changing Drag And File's settings see the section titled Setting 
Preferences.



Customize Toolbar
The toolbar in Drag And File is completely customizable.    You can add or remove over 30 different 
commands, specify any Ctrl or Alt key combination as a hot key and add any program to a toolbar button.

Note: For more information on customizing Drag And File's toolbar see the section titled Setting 
Preferences.



View All Details

Use this setting to have Drag And File show the file name, date, time, size and attributes as part of the file
listing.



View Filenames Only

Use this setting to have Drag And File show only the file name in the file listing.



View Descriptions

Drag And File allows you to attach descriptions to files.    These descriptions will be maintained when files 
are copied, moved and deleted. Use this command to turn on the display of the file descriptions.

Note: For more information on file descriptions, see the section Working With File Descriptions.



Show File Icons
Drag And File can optionally display the icon associated with a file.    The icon will be displayed right 
before the filename.    Files without an icon associated with them will have an icon of a white page 
displayed.    Use this command to turn this option on or off.



Show Toolbar
Use this command to turn on and off the display of Drag And File's toolbar.    Any configured hot keys will 
still be active even when the toolbar isn't displayed.



Show DOS Command Line
Drag And File comes with a licensed copy of    SmilerShell the very powerful DOS command utility.    
When this option is turned on, there will be an edit field at the bottom of all Drag And File windows.    Any 
DOS command can be entered in the window.    File system changes made this way won't be reflected in 
Drag And File unless you have FilsSysChange=ON in your SYSTEM.INI file.    This option is off by default 
because it slows down Windows considerably.    You can run any DOS or Windows program from 
SmilerShell.    
The default for this window is insert but pressing the insert key will toggle on overstrike mode.    All DOS 
commands will be run in a window and will close when the command is finished.    If you wish to keep 
these DOS windows open when the command is finished, place an asterisk before the command.    For 
example, if you type DIR and you want the window to be kept open after DOS finishes displaying the 
directory, enter "*DIR".    Please look for the flyer describing discount upgrades to the stand alone version 
of SmilerShell and a more powerful built-in version.



Actions Menu
This menu offers commands which allow you to work with the files and directories you select.

Related Topics:
Filter
View
Compress
Print Dir List Print File List
Edit File
Copy Diskette
Format Diskette
Tag
Untag
Tag All
Untag All
Tag Branch
Tag Files
Re-tag



Filter

Use the Filter command to open a file specification dialog box. This allows you to specify the name, types,
and attributes of files to appear in the file window.



View

Use the View command to open a Drag And View Gold window. 
The window displays the contents of the currently highlighted file in a format chosen by Drag And File to 
match the file type. If no match is found, a hexadecimal or an ASCII view opens, depending on the 
viewable content of the file.



Compress

This command sends the highlighted or tagged files to Drag And Zip. With Drag And Zip you 
can compress the files into a PKZIP v.2.04 compatible Zip file.    Drag And Zip can also be 
used to run PKZIP or LHA on the tagged files.    Drag And Zip can also compress tagged 
directories.    To compress tagged directories, drag them to the Drag And Zip icon or the 
zipper button.    Just clicking on the zipper button will always compress the tagged files.



Print Dir List / Print File List

Use the appropriate Print command to print a list of either the directory window or the file window.



Edit File

The Edit command allows you to activate the text editor specified in the Options/Settings dialog box and 
load the highlighted file into the editor.



Label Diskette

The Copy Diskette command allows you to make an exact copy of any diskette.    Drag And File does disk
copying in one pass so you don't have to go back and forth between the source and destination disk 
when using the same drive to do the copy.    For best results, use the same size diskette for source and 
destination disks.

Copy Diskette Dialog Box



Format Diskette

Use this command to format a floppy diskette. The contents of the diskette will be destroyed.    You can 
prevent this by choosing the option "Safe Format".

Format Diskette Dialog Box

The options are:

· Make Disk Bootable.    Use this option if you want to be able to start your computer from this disk.

· Quick Format.    Use this option on a diskette that has already been formatted.    This option will 
re-write the boot sector and root directory but will not reformat the diskette.

· Safe Format:    Use this option to save any existing files on the diskette.      This allows you to 
refresh the formatting of a diskette without having to destroy all the files on it.



Tag Shortcut: Right Arrow
The Tag command tags with a red arrowhead the file or directory currently highlighted.



Untag Shortcut: Left Arrow
The Untag command untags the tagged file or directory currently highlighted.



Tag All Shortcut: Ctrl+Left Arrow
The Tag All command tags all entries in the currently active window, directory or file.



Untag All Shortcut: Ctrl+Left Arrow
The Untag All command untags all tagged files or directories in the currently active window.



Tag Branch Shortcut: Ctrl+Shift+B
The Tag Branch command tags a selected directory and all of its branches.



Tag Files Shortcut: Ctrl+Shift+L

The Tag Files command opens a File specification dialog box, which allows you to specify the name, 
types, and attributes of files to be tagged.

Tag files dialog box



Retag Shortcut: Ctrl+Shift+R
The Retag command resets dots to tags. 
After a tagged group of files has been copied, the tag changes to a small red dot. Use this command to 
reset the red dot back to a tag, making possible additional actions on these files as a group. 

Note: Tagging and untagging is normally faster using the hotkeys or the mouse directly, rather than using 
a drop down menu, which adds an extra step to the process.



Window Menu
This menu offers commands which allow you to manage the windows of Drag And File.

Related Topics:
New Window
Cascade
Tile Horizontally
Tile Vertically
Refresh Drive
Refresh Files



New Window

Use the New Window command to open a new Drag And File window.    The drive displayed in the current
window appears in the new window. 



Cascade Shortcut: Shift+F5

Use the Cascade command to arrange the open Drag And File windows on the screen in an overlapping 
manner so the title bars are visible.



Tile Horizontally Shortcut: Ctrl+Shift+F4

Use the Tile Horizontally command to arrange the open Drag And File windows on the screen so that 
each is wholly visible. This command will tile them horizontally.



Tile Vertically Shortcut: Shift+F4

Use the Tile Vertically command to arrange the open Drag And File windows on the screen so that each is
wholly visible. This command will tile them vertically.



Refresh Drive Shortcut: F5

Use the Refresh drive command to update the listing of directories in the left pane of the window.



Refresh Files Shortcut: F4
Use the Refresh files command to update the listing of files in the right pane of the window.



4.10Fmlaunch Menu
Fileman Launcher loads itself automatically into the Drag And File menu bar.
To prevent Fmlaunch from loading in the menu bar:

· Select the Setup program from the Drag And File group in Program Manager and deselect 
Fileman Launcher.

OR-

1. Open a text editor, such as Windows Notepad. 

2. Open WIN.INI from the Windows directory.

3. Under the heading    [addons] locate the line:

FMLaunchDLL=C:\directory\FML.DLL
where directory is the name of the directory where Fileman Launcher is located.

4. Place several semicolons in front of the line:

;;;FMLaunchDLL=C:\directory\FML.DLL
Fmlaunch will no longer appear in the menu bar.

Related Topics:
Zip files (Fmlaunch Menu)
View files (Fmlaunch Menu)
Auto view (Fmlaunch Menu)
Run Programs (Fmlaunch Menu)
Quit Programs (Fmlaunch Menu)
Modify Program List (Fmlaunch Menu)
Menu Title



Zip files (Fmlaunch Menu)
Use the Zip files command to open the Drag and Zip dialog box to run PKZIP on the highlighted file or on 
one or more tagged files.



View files (Fmlaunch Menu)
Use the View files command to open a Drag And View Gold window to display the contents of the 
highlighted file.
If several files are tagged, the Drag And View Gold toolbar includes arrow buttons which allow you to 
cycle through views of the tagged files.



Auto view (Fmlaunch Menu)
Use the Auto view command to load the selected file in an open Drag And View Gold window 
automatically.
In order for this option to function, check the Open view window if necessary option in the 
Settings dialog box of the Options menu.



Run Programs (Fmlaunch Menu)

Quit Programs (Fmlaunch Menu)
Use the Run/Quit Programs commands to activate or close the auxiliary programs that work with Drag 
And File to help you manage files. 
These programs include Drag And View Gold, Drag and Zip, and any other programs you add to the 
list.



Modify Program List (Fmlaunch Menu)
Use the Modify Program List command to manage the auxiliary programs that work with Drag And File.
At a minimum, those programs include Drag and Zip and Drag And View Gold. Other programs may be 
added, up to a total of ten.
Selecting the Modify Program List command opens the Fileman Launcher dialog box.

Fileman Launcher Dialog Box
Note: If the Show as icon button on the right side of the box is not checked, several other options in 
the box are not available.

Related Topics:
Program #n
Run with File Manager
Visible with File Manager
Remember icon position
Show as icon Show normal Show maximized



Program #n
Displays the pathname of the program. If you are adding a new program, type in the full pathname, 
including drive and directory.



Run with File Manager
Check this box if you want this program to load and run automatically when you open Drag And File.



Visible with File Manager
Check this box if you want the program icon to be visible whenever Drag And File is running and visible. 
This choice is available only when Show as icon button is checked.



Remember icon position
Check this to cause the active icon to appear in the last position it occupied, rather than in the default 
position in the lower left corner of the screen. This choice is available only when Show as icon button 
is checked.



Show as icon
Show normal
Show maximized
Select one of these buttons to determine whether the auxiliary program will appear on-screen as an icon, 
in normal size, or maximized. Some programs may not respond to the screen sizing you select here.
Click OK to save your changes and exit. Click Cancel to exit without saving changes.



Menu Title
The default menu title for Fileman Launcher is Fmlaunch.    If you wish to change it to something else, 
choose this item and enter the name in the resulting dialog box.



Working From Multiple Windows
Drag And File allows you to perform operations on files in more than one Drag And File window in a single
operation.    These options are all off by default but they can easily be turned on from the Options/Settings
dialog box.    The operations that you can perform from multiple windows are:

· Copy

· Move

· View Files or Directories

· Compress Files

· Drag And Drop Files or Directories
When any of these operations are turned on the operation will be performed on the tagged or highlighted 
files in all the open Drag And File windows.    As a safety measure, if a copying or moving operation 
results on writing a file on top of itself, the action will not be performed.
Drag and drop from multiple windows will only work when dragging the files or directories to another 
application like Drag And View Gold or Drag And Zip.    If the files are dragged to a toolbar command, 
Drag And File will use the configuration for the command rather than drag and drop.    For example, if you 
have drag and drop from multiple windows turned on but copying from multiple windows turned off and 
you drag files to the copy button, copying will only be performed on the active Drag And File window.



Drag And File Secondary Window
Besides the main Drag And File windows, Drag And File allows you to work with files from more than one 
directory or drive through the Drag And File secondary window.

Related Topics:
Viewing Files in Tagged Directories
Listing All Files
Find Files



Viewing Files in Tagged Directories
 The simplest way to bring up the Drag And File secondary window is to tag a number of directories and 
while still keeping the focus on the directory pane, click on the view button.    The files from the tagged 
directories will be read and listed in the secondary window.    If you turned on view directories from 
multiple windows, you can do this from more than one Drag And File main window.

Drag And File Secondary Window

The listing in the secondary window is very similar to the listing in the main window but listed after the file 
details is the full pathname for each file.    All copy, move, delete, view, compress, drag and drop 
operations can be performed on the files in the secondary window.    
Two options that the secondary window has that the main window doesn't have is sorting the files by path 
and displaying just the duplicate files.
By default, there is a Dupes button on the secondary window toolbar.    Clicking on this button will display 
only the duplicate files in the listing.    The legend in the lower left of the window will say Duplicate Files.    
Clicking on the Dupes button again will redisplay all the files.    The legend on the lower left will then 
display All Files.



Listing All Files
The list all files command also displays the files in the secondary window.    Choosing List All Files will 
bring up the following dialog box:

List All Files dialog box

From the dialog box you can choose the drives that you want to view.    The option to toggle on the display
of just duplicate files is also available with this command.



Find Files
When you search for files Drag And File will use the secondary window to display the file listing.



Adding and Viewing File Descriptions
Drag And File allows you to add descriptions to files.    You turn on this option by choosing View 
Descriptions from the Options menu.    This will change the file listing to just show the filename and the 
description.    Descriptions can be added or modified by choosing Edit Descriptions from the File menu.    
You can also modify the description of a file when you choose rename.    Descriptions are saved in 4DOS 
DESCRIPT.ION files making them compatible with 4DOS and NDOS descriptions.    

Note: Descriptions will be maintained only when View Descriptions is turned on.    Because of the 
overhead in updating all the descriptions it is not possible to maintain the description files in the Drag And 
File secondary window



Using the Built-In DOS Command Line
We have licensed a copy of SmilerShell Lite for Drag And File.    SmilerShell Lite is a Lite version of the 
powerful DOS command utility SmilerShell Pro.    You can turn on the display of SmilerShell Lite by 
checking "Show DOS Command Line" on the "Options" menu.    When active, SmilerShell Lite will appear 
as an edit window on the bottom of Drag And File.
SmilerShell Lite supports command history, editing, and search.    It supports clipboard functions (cut, 
copy, paste) when given from the keyboard with the usual commands.    It can run DOS or Windows 3.1 
programs, and all useful DOS internal commands

Related Topics:
Configuring the DOS Command Line
Using the DOS Command Line Utility
Advanced User Features in the Pro Version



Configuring the DOS Command Line
Choose Configure Command Line from the Options menu.    The DOS Command Options dialog will 
appear.

DOS In Window:    You can run most DOS commands with the SmilerShell Lite and can choose to have 
these commands run full screen or in a DOS window.    The default is to run the commands in a DOS 
Window.
Inactive DOS Windows Stay Visible:    This options determines whether the DOS windows will stay 
around or close after DOS commands are run.    If you choose to have the DOS windows stay around you 
can easily close them all at once by pressing Ctrl+Shift+K from the keyboard.
Insert Mode: Use this to toggle between Insert or Overtype mode
Use Comspec: By default, the DOS command utility, will send all DOS commands to the standard DOS 
command processor, COMMAND.COM.    Some programs like 4DOS, NDOS and others use a different 
command processor.    They specify the command processor in your CONFIG.SYS file with the statement 
"comspec=".    If you choose to have SmilerShell Lite use the command processor specified in your 
CONFIG.SYS file, see that this item is checked.    Inorder to see this option take effect you will have to 
restart Drag And File.    This is only necessary with the Use Comspec option.
Case Sensitive Aliases and Drives to Scan will be grayed out unless you have the pro version of 
SmilerShell.    Bardon Data Systems, producers of SmilerShell Lite, are offering owners of Drag And File a
way to upgrade to SmilerShell Pro, a more powerful version.    SmilerShell Pro lets you create aliases, 
enter more than one DOS command at a time, and change directory very fast, even accross multiple 
drives. SmilerShell Pro is available in two versions.    The "built-in" version replaces SmilerShell Lite within
Drag And File with a much more powerful command line.    The standalone version gives you a powerful 
command line as a separate program.



Using the DOS Command Line Utility
Enter any DOS command into the edit field and press enter.    The command will be run in a DOS window. 
You can configure SmilerShell Lite to have the DOS windows stay open at the end of a command so you 
can see the results of the command or you can configure it to close them when the command is done.
By using the up and down arrow keys, you can find any previously-issued command.    If characters are 
typed before using the up and down arrows, only commands beginning with those letters are displayed.    
Pressing the Escape key clears the command line.    
SmilerShell Lite will run commands full screen or in a window, depending on what the settings are.    If the 
command starts with a right-bracket character (>) it does the opposite for this one command.    So, for 
example, if the command utility is currently set to run commands full screen and the user starts a 
command with a greater than ">" (example: >dir a:) that one command will run in a window.
Inactive windows can be set to either stick around or go away.    If you enter a command starting with an 
asterisk "*" SmilerShell Lite will behave in the opposite manner for this one command.    So, for example, 
say the DOS window state is currently set to make DOS windows vanish after the command ends and 
you start a command with an asterisk (example: *copy file1 b:).    When that command with the asterisk 
exits its "Inactive" window will be left on the screen.    Inactive DOS windows can be easily closed by 
entering Ctrl+Shift+K.
These asterisk and greater than flags can be combined if they are the first two characters on the line.    
(For example: >*myprog param1 param2 param3)    It doesn't matter which flag comes first.
When a DOS command is entered from SmilerShell, then after that command exits, SmilerShell knows to 
actively grab back the focus.    This allows the user to simply keep typing, just like at the DOS prompt.
The DOS command line utility supports drag-and-drop, so you can select files from Drag And File or any 
other drag and drop server.    When the user drops the files onto the SmilerShell control, their names will 
appear in the edit area.    To save space on its command line, SmilerShell tries to use shorter "relative" 
pathnames when appropriate.



ADVANCED USER FEATURES IN THE PRO VERSION
The enhanced Pro version of the SmilerShell does everything the Lite version does, and in addition 
includes some advanced features.
The Pro DLL supports aliases, and these aliases can have run-time parameters (%1 %2 etc.) like batch 
files.    It can run multiple commands on one line, and unlike everything else in Windows, these 
commands are run synchronously -- the next one doesn't start until the previous one completes.
Put these together and you can create parameterized multi-command aliases, which are in effect a built-in
SmilerShell scripting language.
Another Pro feature is its DC quick-directory-change function.    Rather than typing CD and a long path, 
the user need only type DC and the first few letters of the final directory name, and instantly they are 
taken there.    DC works across multiple drives, so it is not necessary to change drives before using DC to 
change directory.    The user can set which drives DC should be aware of, and when to rebuild its DC 
indexes (useful when dealing with large or volatile configurations, such as on a network). 
There is a flyer offering an upgrade to SmilerShell Pro enclosed with your copy of Drag And File.    You 
can also obtain a copy of SmilerShell Pro from Bardon Data Systems at (510) 526-8470.



Drag And View Gold
Drag And View Gold allows you to view the contents of a file or files without having to run the program 
that created them. 

Drag And View Gold main window

Drag And View Gold can view files created by popular word processors, databases, spreadsheets, and 
graphic programs. It uses viewers to display the files in their native format (or a format close enough to 
their native format). That way you can easily see what the file contains without unreadable formatting 
codes. In addition, you can view any file in ASCII or hexadecimal format. 
Drag And View Gold offers these additional features:

· Opens multiple windows to compare files

· Searches for text in any file or a hexadecimal string in the Hex viewer

· Goes to any cell in a spreadsheet, any record in a database, and any address in the hexadecimal
view of a file

· Views a list of files viewed during the current session, and users can click on a listed file to re-
view it

Related Topics:
Viewing Files
Drag And View Gold Windows
Exiting Drag And View Gold
Drag And View Gold Commands
File Menu
Edit Menu
View Menu
Options Menu
Zoom Menu
Page Menu
Filelist Menu
System Menu





Viewing Files
Drag And View Gold offers three ways to activate the file viewer:

· Drag a highlighted file or several tagged files from Drag And File and drop on the minimized icon 
or on the already open Drag And View Gold window.

· Click on the View button in the Drag And File toolbar to view a highlighted or tagged file.

· Choose View files from the Fmlaunch menu to view a highlighted or tagged file.
When more than one file is tagged, Drag And View Gold views the first file and lists all files in the Filelist, 
up to 20 files.
If Drag And View Gold cannot open a viewer to display the file in its native format, it displays the file either
in ASCII text or in hexadecimal format.



Drag And View Gold Windows
After the first viewing window is open, the Drag And View Gold icon remains active. Any file dropped on it 
will open another window. Clicking on the New Window button will also open a new window from the 
same Filelist.
Drag And View Gold will open as many windows as your computer's memory will support. 
Any open Drag And View Gold window can be closed, maximized or minimized to an icon.    Drop a file on
a minimized Drag And View Gold window to restore the window and display the file. 
To close all windows:

1. Click on the Drag And View Gold icon to activate the system menu.

2. Select Close all windows.

Drag And View Gold closes all windows but does not close the program. The icon remains visible.



Exiting Drag And View Gold
Click on the active Drag And View Gold icon to open the system menu. Choose Close from the menu.
On closing, Drag And View Gold closes all open windows.



Drag And View Gold Commands
Drag And View Gold's main window includes a toolbar which offers one-click access to the most useful 
functions.    This toolbar can be modified in the same way as the Drag And File toolbar.    

Related Topics:
Launch
Copy
Select All
New Window
Goto
Find
Last, Next
Print
Play



Launch
The Launch button runs the program associated with the file type currently displayed.    
The Associate... command from the File menu of Drag And File specifies programs to associate with 
filename extensions. If the file type currently displayed has an associated extension, Drag And View Gold 
will launch that program and load the file. If association is lacking, Drag And View Gold opens a dialog 
box which allows you to establish an association.
If the file you are viewing is an executable program, Drag And View Gold will run it when you choose this 
command.



Copy
The Copy button copies selected areas of views to the Windows Clipboard.    You can select areas by 
placing the mouse arrow at the upper left of the portion that you want to select.    Click the left mouse 
button and hold it down while you drag the mouse pointer to the lower right of the portion that you want to 
select.    Let go of the mouse button when you've finished selecting the area that you want.    You can also 
use the edit menu and choose "Select All" to select the entire area of a view.



Select All
This command will select all of the view for copying to the clipboard or printing.



New Window
The New Window button opens a new window with the same file list as the current window.    
Choose this command to view the same files in two or more windows.    Arrange these windows to view 
different parts of the same file or another file side by side.    Drag And View Gold supports as many open 
windows as your computer's memory will sustain.



Goto
For database files, the Goto button opens a dialog box to specify a record to view.
For spreadsheet files, the Goto button opens a dialog box to specify a cell to view.
In the Hex viewer, the Goto button opens a dialog box to specify a hexadecimal offset for the viewer to 
show.
For all other file types, this button is inactive.



Find
The Find button opens a dialog box which allows you to specify a text string to search for. Choose OK to 
find the first match. Choose OK again to find each subsequent match.
The search can be case-sensitive in all viewers except the Hex viewer. In the Hex viewer you can search 
in ASCII as well as hexadecimal format.
This button is inactive for graphic file types. 



Last, Next
The Last and Next buttons allow you to scroll through the files in the Filelist.    These buttons are active 
only when the Filelist contains more than one file.



Print
With the print button you can print either the entire document being displayed or just the selected area.



Play
The Play button will appear only when the current file being viewed is a Windows sound file with a .WAV 
extension.    
Drag And View Gold will play the Wav file if you have a sound driver installed.    Choose the Play button to
hear the file again.



File Menu
Open (File Menu)
Exit (File Menu)
Word Wrap (File Menu)



Open (File Menu)
Use the Open command to open a new file in the current window.    
If there is a special file viewer for the file, it will be shown in its native format.    Otherwise, it will be shown 
with either the ASCII viewer (if the file is made up chiefly of readable characters) or the Hex viewer.
The name of the file will be added to the top of the Filelist displayed on the Filelist menu.



Exit (File Menu)
Use the Exit command to close the current window.
Note that this command does not close the program. To close the program, use the System menu which 
is available by clicking on the program icon.



Word Wrap (File Menu)
The Word Wrap command    is a toggle which turns word wrap on or off when viewing ASCII files.    



Edit Menu
Copy (Edit Menu)
Select All (Edit Menu)



Copy (Edit Menu)
This command copies selected areas of views to the clipboard.    You can also use the key combination 
Ctrl+C and do the same.



Select All (Edit Menu)
This command will select the entire view for copying or printing.



View Menu
ASCII (View Menu)
Hex (View Menu)
Viewer (View Menu)



ASCII (View Menu)
Use this command to view a file in ASCII format.



Hex (View Menu)
Use this command to view a file in hexadecimal format.    The Hex viewer displays a file as both a series 
of hexadecimal (base 16) numbers and ASCII characters.



Viewer (View Menu)
Use this command to view a file in its native format    (using one of Drag And View Gold's viewers) after 
viewing the file in either ASCII or hexadecimal format.



Options Menu
Fonts (Options Menu)
Settings (Options Menu)



Fonts (Options Menu)
The Fonts command opens a dialog box to choose a font for the file viewers.    The specified font applies 
to all viewers' display text except the Hexadecimal viewer.



Settings (Options Menu)
The Settings command opens a dialog box which offers choices to control the appearance of the Drag 
And View Gold active icon, file viewing windows.



Zoom Menu
The zoom menu allows you to zoom views up to five times.



Page Menu
This menu will be available only when viewing multi-page spreadsheets and graphics.    Currently the only
multi-page graphics supported are TIFF and DCX/DCF.    Lotus WK4, Quattro Pro for Windows and Excel 
5 are the multi-page spreadsheets that are supported.



Filelist Menu

Filelist (Filelist Menu)
The Filelist command displays the names of files that have been dragged to the open window or opened 
from the file menu in the current session of Drag And View Gold.    The current file has a check before the 
name.    Highlighting another file and pressing Enter or clicking on another file name will display that file.



System Menu
Open the system menu by clicking on the active icon.

Related Topics:
Settings (System Menu)
Close All Windows (System Menu)
Close (System Menu)



Settings (System Menu)
The Settings command opens a dialog box which offers choices to control the appearance of the Drag 
And View Gold file viewing windows and icon.



Close All Windows (System Menu)
The Close All Windows command closes all the currently open Drag And View Gold windows.    The 
command does not close the program, and the icon remains.



Close (System Menu)
The Close command exits the Drag And View Gold program and closes all open Drag And View Gold 
windows.



Drag and Zip
About Drag And Zip
Drag And Zip Settings



About Drag And Zip
Drag And Zip is a utility that brings drag and drop ease to file compression.    You can use its built-in 
zipping and unzipping to easily manage Zip files from within Windows. You can also    use Drag And Zip 
as a Windows interface to the PKZIP compression program from PKWARE, Inc., or the LHA compression 
routine. And, you can also make self-extracting archives.

Drag And Zip dialog box

Drag And Zip allows you to compress files by dragging them from the file list and dropping them on the 
active Drag And Zip icon or clicking on the Zip button in the toolbar. Drag and Zip opens a dialog box with 
fields for you to enter the name of the archive file and a path for its location. Drag And Zip also allows you 
to drag and zip subdirectories.
Drag And Zip creates Zip files that are compatible with PKZIP version 2.04g.    It can unzip any files made 
with version 2.04g or 1.1. To use Drag And Zip to build and extract LZH files, you must have a copy of 
LHA.EXE.    Drag and Zip will not work with LHARC.EXE.
Viewing the contents of a Zip file and extracting files from a Zip file are as easy as double clicking on the 
Zip file in the file pane.
Drag And Zip's viewer, Zip View, will pop up and display a list of the files contained in the compressed file.
Listed files can then be selected by highlighting a single file or tagging one or more. You may perform a 
variety of operations on the selected files, including:

· Extract 



· Delete

· Temporarily extract to a unique program group for further examination

· Convert to a self-extracting file (if you have ZIP2EXE.EXE on your system)

· Run or load to an associated program

· Modify and replace or restore

· Scan for viruses    



Drag And Zip Settings
To change Drag And Zip settings:

1. Click on the active Drag And Zip icon.

2. Choose Settings from the pop-up menu.

The Drag And Zip Settings dialog box appears. 

3. Fill in the options as described below.

Settings dialog box

Related Topics:
Icon always visible
Icon stays where last put
Built-in Zipping
PKZIP version 2 or greater
Output directory
PKZIP/PKUNZIP location    LHA location
Icon caption



Icon always visible
This option makes Drag And Zip's icon visible at all times.    (If Fileman Launcher is running, it will 
automatically make the Drag And Zip icon visible.)



Icon stays where last put
This option causes Drag And Zip to remember and reuse its last icon position.    (Fileman Launcher does 
this automatically.)



Built-in Zipping
This option causes Drag And Zip to use the built-in PKZIP 2.04 compatible zipping rather than an external
copy of PKZIP. 



PKZIP version 2 or greater
Check this statement if it is true; do not check it if you are running any version of PKZIP earlier than 
version 2.0. Drag And Zip passes switches and commands to PKZIP and PKUNZIP, which depend on this
information. 



Output directory
Accept one of the two default directories (the current directory, or the directory from which you dragged 
files to be zipped) or type in another directory name.



PKZIP/PKUNZIP location 
LHA location
Enter the drive and directory where your copies of PKZIP.EXE, PKUNZIP.EXE, and LHA.EXE are kept.



Icon caption
Enter text to use as a caption beneath the Drag And Zip icon when it is an active icon. A blank field will 
produce a blank line under the active icon.
 



Zip View
Zip View is a viewing utility that works with Drag And File.
You run Zip View by double clicking on a Zip file from within Drag And File.    You can also launch Zip View
by dragging a single Zip file to the Drag And Zip icon.
Zip View can:

· Display a list of files contained within an archived file

· Delete and run files

· Extract files singly or in groups from a zip archive

· Make compressed files self-extracting (if ZIP2EXE.EXE is present on your system)

Zip View main window

Related Topics:
Selecting Zip files to examine
Zip View Toolbar
Zip View Menus



Selecting Zip files to examine
Zip View offers three ways to identify a zipped file or files to view.
Note: These methods depend on your having allowed the setup program to record an association 
between .ZIP files and Zip View. If you have not done so, record the association before proceeding. If 
necessary, consult Microsoft Windows Users' Guide for information on associating files.

· Double click on the file in the filelist.

· Highlight the file and drag and drop it on the active Zip View icon or on the open Zip View window.

· Select Open from the Zip View File menu, and choose the file you want to view.
The Zip View window opens, showing the contents of the zipped file. In addition, the window displays file 
names, file sizes, date and time files were saved, and the total number of files and their collective size.

Related Topics:
Tagging/Highlighting Listed Files



Tagging/Highlighting Listed Files
The files included in a zipped file displayed in Zip View can be highlighted one- by-one or tagged as a 
group.
To highlight a file:

· Click on the file

· Start typing the filename. Zip View will display your typing in the finder window. The highlight will 
move to the file in the filelist which most closely matches the letters you type.

To tag a file:
· Ctrl+LButton click on a file

· RButton click on a file

· Press the spacebar when the file is highlighted

· Press the right arrow key when the file is highlighted

· Use the same procedure to untag tagged files one by one.
To tag/untag all files:

· Ctrl+right arrow key to tag all files

· Ctrl+left arrow key to untag all files



Zip View Toolbar
The toolbar includes single click buttons which represent the most frequently used actions.

Related Topics:
View Keyboard:    Alt-V
Launch Keyboard:    Alt-L
Extract
Scan
Check Out



View Keyboard:    Alt-V
Use this button to cause Zip View to extract the file from its compressed archive,    load a file viewer and 
display the contents of the file. (To adjust the display, see options in the Settings menu.)
Delete Keyboard:    Alt-D
Press this button to delete any highlighted or tagged files.



Launch Keyboard:    Alt-L
Press the Launch button to extract any file from the highlighted zip file and, depending on the nature of 
the file, do the following:

· If it is a program, run it. 

-OR-

· If it is a data or graphic file, run its associated program and load the file.    If no program 
association exists for the file, you will be prompted to choose one.



Extract
Press the Extract button to open a dialog box to specify:

· Which files (tagged, highlighted, or all) to extract

· The directory in which to store the extracted files

If the specified directory does not exist, Zip View will ask if you wish to create one.
In addition, press the Browse Arguments button to open a second dialog box where you can specify:

· Create directories stored in the zip file (if the file was stored with this information)

· Overwrite existing files and suppress the default overwrite warning message

· Enable up to four arguments which may increase compression speed
If you have highlighted an LZH file for extraction, the dialog box is similar to that for zipped files, but 
presents fewer choices.



Scan
Press the Scan button to run a virus scanning program if you have one installed. 
Zip View must be able to pass arguments to the scan program in order to load and run it. DOS-based 
programs normally run this way, but few Windows-based programs do. If your scanning program is 
Windows-based, Zip View may not be able to run it successfully.



Check Out
Press the Check Out button to create a Program Manager group, temporarily extract the highlighted or 
tagged files and place them as items in the group.
The Check Out feature allows you to run a program quickly. The procedure also includes a virus scan as 
an option before running the program.



Zip View Menus
Open (File Menu)
About (File Menu)
Exit (File Menu)
Sort ( Main Menu Bar)
Make EXE (Options Menu)
Convert to ZIP/LZH (Options Menu)
Fonts (Options Menu)
Settings (Options Menu)
Output directory
Display options
Built-in Unzipping
PKZIP version 2 or greater
PKZIP/PKUNZIP location
LHA location
GUNZIP location
Anti-Virus
Viewing Program



Open (File Menu)
Use the Open command to list the files compressed in a zip file you select by browsing the directory tree 
or by typing in a filename.
This technique is especially useful to see the files archived in a self-extracting zip file which cannot be list-
viewed by double-clicking on it. 



About (File Menu)
Choose the About command to open a box with information about the version of Drag And Zip, and the 
address and telephone number of Canyon Software.



Exit (File Menu)
Select the Exit command to quit Zip View.



Sort ( Main Menu Bar)
Use the Sort command to sort the listing of files in a zip file by Filename, Extension, Date and Time, or 
Size.    You can also save the sort as a default.



Make EXE (Options Menu)
Choose the Make EXE command to make a highlighted or tagged files self-extracting.

Note: This action is available only if you have ZIP2EXE.EXE from PKWARE, Inc. installed in the same 
directory with your copies of PKZIP and PKUNZIP.



Convert to ZIP/LZH (Options Menu)
Use the Convert to ZIP/LZH command to convert a ZIP file to an LZH    file and an LZH file to a ZIP file.    
In a dialog box you may change the filename and the destination directory.    To convert a ZIP file to an 
LZH file requires copies of PKUNZIP and LHA.    To convert an LZH file to a ZIP file requires copies of 
LHA and PKZIP.



Fonts (Options Menu)
Use the Fonts command to open a standard Windows 3.1 font dialog box from which you can change the 
default font in Zip View.



Settings (Options Menu)
Use the Settings command to set preferences and defaults for Zip View.



Output directory
Use this option to choose the default output directory to store files you unzip. Two choices are available:

· Current Directory - the directory in which the file you are currently viewing resides

· Previous Zip Directory - the last directory that you extracted files to



Display options
Use these options to choose information ZipView will show in the file display.    
Normally, any stored path information appears.    But select Show CRC to show CRC information 
instead. Your choice here becomes the default.



Built-in Unzipping
Use this option to toggle between using Zip View's built-in zipping and an external copy of PKUNZIP.



PKZIP version 2 or greater
Check this statement if it is true; do not check it if you are running any version of PKZIP earlier than 
version 2.04g. Drag And Zip passes switches and commands to PKZIP and UNZIP which depend on this 
information. 



PKZIP/PKUNZIP location 

LHA location 

GUNZIP location
Enter the drive and directory where your copies of PKZIP.EXE, PKUNZIP.EXE,    LHA.EXE and GUNZIP 
are kept.



Anti-Virus
Zip View comes with a built-in copy of Integrity Master for scanning viruses.    If you would rather use a 
different virus scanner, enter the path and the name of the anti virus program for Zip View to use when 
you request a virus scan.    In the second field, enter commands ("arguments") for your virus scanner for 
ZipView to pass to the scanning program to make it work.    

Put *.* where you want Zip View to substitute the drive and directory of the files that you want 
scanned.



Viewing Program
Enter the directory and the filename of the file viewer. The default entry is for Drag And View Gold.




